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1. Introduction 

1.1. Objective 

This is the official guide for the HubSpot Adapter for SAP Integration Suite. This guide 

covers all relevant information for integration developers to start working with the 

HubSpot adapter. Read this guide carefully before using the Adapter. 

1.2. Coding Samples 

Any software coding and/or code lines/strings ("Code") included in this documentation 

are only examples and are not intended to be used in a productive system environment. 

The Code is only intended to better explain and visualize the syntax and phrasing rules 

of certain coding. The correctness and completeness of the Code given herein are not 

guaranteed. 

1.3. Internet Hyperlinks 

The documentation may contain hyperlinks to the Internet. These hyperlinks are 

intended to serve as a hint about where to find related information. The availability and 

the correctness of this related information or the ability of this information to serve a 

particular purpose are not warranted. 

1.4. Overview 

HubSpot is a dynamic platform enabling seamless integration across departments such 

as marketing, sales, and customer service. Organizations utilize HubSpot's CRM, 

Marketing hub, Sales hub, or CMS hub to expand reach securely. As a leading CRM 

platform, HubSpot assists businesses in attracting visitors, converting leads, and closing 

deals, essential for modern enterprises to streamline operations and enhance customer 

engagement.  

The key aspects of HubSpot and the functionalities it offers are as follows: 

• Multi-Platform Integration: Connects with various business platforms like 

CRMs, ERP systems, and e-commerce sites. 

• Analytics and Reporting: Use HubSpot’s reporting tools to track marketing, 

sales, and service performance. 



• CRM:  Tool to help businesses manage and track leads and customers. 

• CMS Hub:  Used for building and managing websites, blogs, and landing pages. 

• Marketing Hub: Offers tools for email marketing, social media, content 

management, and analytics. 

1.5. Features 

The HubSpot Adapter provides the following key features: 

• Secure authentication: Secure authentication with OAuth 2.0 and private app 

access ensures HubSpot securely connects with other applications. Each API 

request between HubSpot and external platforms is safeguarded. 

 

• Support for multiple HubSpot operations: The HubSpot adapter supports 

various CRUD operations like Create a batch of contacts, Read a deal, Update a 

company, Delete selected template, etc. 

 

• Support for multiple API versions: HubSpot supports multiple API versions with 

an editable API version field enabling users to input the latest supported version. 

 

• Support for XML & JSON: HubSpot Adapter extends support for multiple 

payload formats. XML and JSON are fully incorporated throughout the adapter. 

 

• HubSpot Eclipse plug-in: The Eclipse plug-in helps to generate all necessary  

up-to-date message XSDs for specific resources and the custom objects in the 

HubSpot. 

 

• Batch Operations in HubSpot: Efficiently manage large datasets with bulk 

updates, deletions, and creations across contacts and deals, enhancing 

productivity. 

 

• Pagination: You can query efficiently with our integrated pagination support. 

HubSpot adapter supports querying of all records of a resource using Offset & 

Limit. 

 

• Dynamic Configuration Support: The HubSpot adapter allows operations to be 

executed by selecting options from a dropdown in Basic Configuration or 

specifying a relative URL in Advanced Configuration. 

  



2. Installation and Configuration 

This section details the file(s) available as part of the installation package and the 

prerequisites to configure the HubSpot adapter. 

 

The HubSpot adapter is available as part of your SAP Integration Suite license. 

You would also require an installation of Eclipse Workbench. For more information, see 

HubSpot Plug-in Installation. 

Before you begin, you must download the HubSpot plugin bundle from the SAP 

Marketplace that contains the file(s) listed in the following section. 

2.1. Package Details 

The HubSpot plug-in installation package contains the following file: 

File Type File Name Description 

Plug-in File HubSpot-plug-in_<version>.jar This file is used to install the plug-in. 

2.2. Prerequisite 

Before you begin, you must: 

• Download and install the HubSpot plugin bundle from the SAP Marketplace. 

• Download and install the SAP-recommended version of Eclipse. 

Note: It is recommended to use Eclipse Oxygen. However, the plugin remains 

compatible with all latest versions of Eclipse. 

To get the latest SAP recommendations, see SAP Development Tools. 

2.3. Adapter Installation on Cloud Foundry 

Before the adapter can be used in the Cloud Foundry environment, it must be deployed 

to the SAP Integration Suite tenant. 

https://tools.hana.ondemand.com/#cloudintegration


2.3.1. Prerequisites 

To deploy the HubSpot adapter, you must have access to the SAP Integration Suite 

license. 

2.3.2. Procedure 

You can deploy the adapter using the following methods: 

 

The following installation procedure is compatible with Apache Camel 2, 

Apache Camel 3, and Edge Integration Cell (EIC) platform. 

2.3.3. Adapter Installation by creating a New Integration Flow 

The HubSpot adapter is available for selection in the receiver adapter list and can be 

deployed in the Design tab directly as you use it in an Integration flow. 

Purpose 

To install an adapter for use in your Integration flow. 

Procedure 

Go to Design workspace and select the integration package where you want to create a 

new Integration flow. 

1. Click Edit to make the package editable. 

2. Go to the Artifacts tab. Click Add and select Integration Flow. 

3. Enter Name and ID for your flow. Additionally, select Runtime Profile from the 

drop-down and choose Sender and Receiver systems from the list       . Finally, 

click Add to create the integration flow. 

4. Go to the newly created integration flow and click Edit to make it editable. 

5. In the integration flow, click End to add a Connector       between the End and 

the Receiver Box. 

A drop-down with the available adapters appears. The HubSpot adapter should 

show up in the list. 

6. Select the HubSpot adapter from the list. The adapter is now imported which 

triggers an adapter deployment. Once HubSpot Adapter is deployed, a success 

message is displayed.  



After the above steps are done, the HubSpot Adapter is successfully deployed in your 

Design workspace of the SAP Integration Suite tenant.  

2.3.4. Adapter Installation without Creating a New Integration 

Flow 
 

 

The following procedure explains how the HubSpot adapter is migrated from 

the Discover workspace to the Design workspace of the SAP Integration tenant. 

This method is useful for scenarios where integration flow packages are migrated from 

development to a higher environment such as Production. 

The HubSpot adapter can be imported into the Design workspace without creating an 

integration flow. Use the Transport Management Service (TMS) to import/transport the 

HubSpot adapter to a higher environment. Alternatively, If the TMS is not available in 

the landscape, the adapter package can be imported to the Design workspace by 

copying it from the Discover workspace.  

Purpose 

To import the HubSpot adapter to the Design workspace by copying the integration 

package from the Discover workspace. 

Procedure 

1. Go to Discover workspace. 

2. In the search box, search for HubSpot adapter for SAP Integration Suite 

package.  

3. Select the package and click Copy. This copies the package from the Discover 

workspace to the Design workspace. 

4. Go to Design workspace and select the copied HubSpot adapter for SAP 

Integration Suite package.  

5. In the Actions tab of the selected package, click Deploy. This completes the 

adapter deployment to the Design workspace. 

 

 

 



2.4. Monitor the Deployment Status 

After the adapter deployment is complete, you can check the status in the Monitor 

section. 

Purpose 

To check the status of the deployed adapter. 

Procedure 

1. Under the Monitor tab, click Integrations and APIs. This opens the Overview 

page. 

2. On the Overview page, go to Manage Integration Content section and click 

All. This opens Integration Content page with a list of all the deployed adapters. 

3. Here, you can check and confirm the deployment status of your adapter. 

 

2.5. HubSpot Plug-in Installation 

2.5.1. Prerequisites 

Before you begin, you must download the HubSpot Plug-in bundle from the SAP 

Marketplace. For more information, see HubSpot Installation and Configuration. 

2.5.2. Procedure 

To install the HubSpot Plug-in, follow these steps: 

1. Download and install Eclipse Oxygen 3a from Eclipse Oxygen.  

https://www.eclipse.org/downloads/packages/release/oxygen/3a


2. After Eclipse installation, go to your Eclipse installation folder (Example: 

C:\Program Files (x86)\oxygen\eclipse) and open the Plug-in folder. 

3. Copy the HubSpot Plug-in JAR file (that you downloaded from the SAP 

Marketplace) into the Plug-in folder. 

4. Open Eclipse Oxygen and go to Window > Perspective > Open Perspective > 

Other. 

 

5. Select HubSpot Adapter Workbench and click Open. 

 



6. Go to Window > Preferences > HubSpot Preferences. 

 

7. In the HubSpot Preferences widget, fill in the HubSpot Settings details. You 

can retrieve these details from your HubSpot tenant. To retrieve Settings details 

and respective login credentials to set up a HubSpot connection to the specific 

tenant, see HubSpot Adapter Guide. 

8. Verify the settings details and the credentials by clicking the Test Connection 

tab. 

9. Upon successful test, click Apply and Close to complete the installation. 



 

3. Getting Started: HubSpot Adapter 

This section explains how to configure the HubSpot adapter for SAP Cloud Integration. 

You can find information about adapter architecture, application configuration, 

authentication, and supported versions for HubSpot Adapter. Finally, you can find 

additional information like troubleshooting tips under HubSpot Support. 

3.1. Architecture Overview 

The HubSpot adapter is designed to function as a receiver adapter. In such a scenario 

where the HubSpot Adapter is used as a receiver adapter, SAP Cloud Integration acts as 

the initiator of the calls. 

The HubSpot adapter supports CRUD operations such as Create an association, Read a 

deal, Update a company, Delete a file, etc. For more information, see Operations 

supported in HubSpot. 



The figure below demonstrates the request-reply step using a HubSpot adapter and 

gives a high-level representation of how the adapter works. 

 

 

The HubSpot adapter works as a Request-Reply step in the integration process, 

responsible for connecting and interacting with HubSpot to invoke its operations. The 

Eclipse Plug-in is used to help the user generate XSDs of the different categories and 

entities that are available in your HubSpot tenant.  

The XSDs generated by the Eclipse Plug-in can be imported in an Integration Flow and 

used in mappings. 

• For instance, it can be added before the Request-Reply Step in the above mapping. 

This way, you can create the correct XML request message to create or modify a 

resource in HubSpot (see the Mapping Step on the left side of the Request-Reply 

Step). 

• Similarly, you can use the XSDs to create a mapping to handle the response message 

returned by HubSpot (see the Mapping Step on the right side of the Request-Reply 

Step).  

Furthermore, the Eclipse Plug-in XSD Generator helps you generate up-to-date XSDs for 

your HubSpot resources for all the different operations. For more details about the 

HubSpot plug-in and XSD Generator configuration, see HubSpot Plug-in Installation.  



3.2. Application Configuration 

You can connect to HubSpot via the HubSpot adapter using your user credentials. For 

information related to account creation and setup, see HubSpot Documentation. 

3.3. Authentication 

This section details the authentication mechanism supported by HubSpot Adapter in 

SAP Cloud Integration. The HubSpot adapter supports two authentication methods: 

OAuth2 and private app access. OAuth is a secure authentication method that uses 

authorization tokens instead of passwords to link your app with a user account. 

Initiating OAuth access is the first step in enabling users to install your app within their 

HubSpot accounts. It requires an OAuth2 Credential Alias for OAuth2 and a Token Alias 

for private apps. 

Private apps enable API access to specific data within your HubSpot account. You can 

control what each private app can request or modify in your account, generating a 

unique access token for your app. 

 

You must be a super admin to access private apps in your HubSpot account. 

3.3.1. Creating Credentials in Security Material 
 

As there are two types of authentication methods. Credentials can be created for each 

type as follows: 

 

3.3.1.1 OAuth2 authentication 

Purpose 

To create credentials in Security Material for Oauth2 authentication. 

Procedure 

1. In SAP Integration Suite, navigate to Monitor > Integrations and APIs. This 

opens the Overview page. 

2. On the Overview page, go to Manage Security section and click Security 

Material. 

https://knowledge.hubspot.com/get-started/set-up-your-account
https://knowledge.hubspot.com/settings/hubspot-user-permissions-guide#super-admin


 

3. On Manage Security Material page, click Create to select OAuth2 

Authorisation Code from the dropdown. 

 

4. In the Create OAuth2 Authorization Code popup, provide the below details. 

Field Description 

Name 

Specify the name for the security artifact. 

The artifact name is used as an alias for the confidential data assigned 

by this parameter. 

Description Enter a description for the artifact (optional). 

Provider 

Enter the name of the provider of the platform on which you created 

the OAuth2 client. 

Example: Generic 

Authorization 

URL 

Provide the Authorization URL for authorizing the OAuth client to 

access resources of a user. 

Token Service 

URL 
Address of the token service that issues the access token. 



Field Description 

Redirect URL 
Displays the URL you need, when creating the OAuth Clients/App in 

OAuth Authorization Server/Token Server. 

Client ID Specify the ID of the client you want to connect to. 

Client Secret Specify the Secret key of the client to which you are connecting. 

Send As 
Body Parameter: Send the Client ID and Client Secret in the request 

body when calling the Authorization URL or Token Service URL. 

User Name Name of the user whose resources the OAuth2 client gets access to. 

Scope 

OAuth2 scopes protecting the access to the resources. 

The scope value is added to the Authorization URL (see above) as 

query parameter and is also added to the Token Service URL, in case of 

the "authorization_code" grant type request; but is not added to the 

Token Service URL in case of the "refresh_token" grant type request 

(see above). 

 

If you add more than 1 scope, you need to separate your 

scopes by a blank space. 
 

5. Click Deploy to complete the process. 

3.3.1.2 Private app 

Purpose 

To create credentials in Security Material for the Private app authentication mechanism. 

Procedure 

1. In SAP Integration Suite, navigate to Monitor > Integrations and APIs. This 

opens the Overview page. 

2. On the Overview page, go to Manage Security section and click Security 

Material. 



 

3. On Manage Security Material page, click Create to select Secure Parameter 

from the dropdown. 

 

 

 

4. In the Create Secure Parameter popup, provide the below details. 

Field  Description 

Name 

Specify the name of the security artifact. The artifact name is used as 

an alias 

for the confidential data. 

Description Enter a description for the artifact (optional). 

Secure 

Parameter 

Enter the confidential value of the attribute. 

The permissible length of the secure parameter for Cloud Foundry is a 

maximum of 4096 characters. 

Repeat Secure 

Parameter 
Repeat the confidential value of the attribute. 



5. Click Deploy to complete the process. 

When you refresh the Manage Security Material page, the new artifact is displayed 

(with Type Credentials) in the artifact table. 

3.4. Supported version 

The supported API versions are listed in the table below. 

• v1 

• v2 

• v3 

• v4 

 

The supported category and entity vary depending on the API version. 

 

  



4. HubSpot Adapter Configuration 

This section describes the parameters to be configured for your HubSpot adapter. You 

need to configure the General, Connection and Processing tabs. A description and 

example usage for every field has been added. 

HubSpot Receiver Adapter 

In this section, you will learn how to configure the HubSpot receiver adapter. On 

selecting the HubSpot adapter from the list of adapters, you must configure the 

General, Connection, and Processing tabs. 

4.1 General 

The General tab provides an overview of basic adapter information including Channel 

and Adapter details. 

 

Only the Name and Description fields are editable. 

Field Description 

Name Name of the adapter flow 

Description Description of the adapter 

 



4.2 Connection 

The Connection tab contains connection and authentication parameters for HubSpot. 

Using Credentials 

The Security artifact created in the previous section should be used in the Connection 

tab of the Adapter as shown in Figure below. 

 

The connection tab contains the following fields: 

Field Description 

Address 

Specify the recipient’s Endpoint URL.  

 

Example: https://api.hubapi.com 

Authentication Select your Authentication Method. 

OAuth2 Credential 

Alias 
Specify the OAuth2 Credential alias. 

Token Alias Specify the Token alias. 

Reuse Connection Enable this checkbox if you need to reuse the connection. 

Connection Timeout 

(in ms) 

Specify the maximum waiting time (in milliseconds) while 

establishing a connection with HubSpot. 

Response Timeout 

(in ms) 

Specify the maximum waiting time (in milliseconds) for a 

response message to be received from HubSpot. 

  



4.3 Processing 

The Processing tab lists all the operations that can be performed on the database 

through the adapter. 

 
 

Field Description 

Processing Details 

Configuration Type 

Specify the configuration type, select Basic to use the dropdowns 

and parameter text fields. Select Advanced to provide the relative 

URL (endpoint excluding the host). 

API Version 
Select the version of the API to be used for this interaction with 

HubSpot. 

Category Select the required Category. 

Entity 
Specify the HubSpot Entity based on which the operation will be 

performed. 

Operation 

Specify the type of action to be executed. This field is based on 

the selection of the above fields. For more information, see 

Supported Operations. 

Relative URL 
Specify the endpoint path, excluding the Host. Example: 

/crm/v3/objects/contacts. 



Field Description 

HTTP Method Select the HTTP Method. 

Entity ID 

Specify the Entity ID corresponding to the Entity selected in the 

drop-down above. 

Example: For Entity 'Contacts' enter the contact ID. 

From Object Type 
Specify the "From Object Type". Note that this value can also be 

read dynamically. 

To Object Type 
Specify the "To Object Type". Note that this value can also be 

read dynamically. 

Object Type 
Specify the Object Type. Note that this value can also be read 

dynamically. 

Object ID 
Specify the Object ID. Note that this value can also be read 

dynamically. 

To Object ID 
Specify the "To Object ID". Note that this value can also be read 

dynamically. 

From Object ID 
Specify the "From Object ID". Note that this value can also be 

read dynamically. 

App ID 
Specify the App ID. Note that this value can also be read 

dynamically. 

Task ID 
Specify the Task ID. Note that this value can also be read 

dynamically. 

Event Template ID 
Specify the Event Template ID. Note that this value can also be 

read dynamically. 

Event ID 
Specify the Event ID. Note that this value can also be read 

dynamically. 

Token Name 
Specify the Token Name. Note that this value can also be read 

dynamically. 

Group Name 
Specify the Group Name. Note that this value can also be read 

dynamically. 

Property Name 
Specify the Property Name. Note that this value can also be read 

dynamically. 



Field Description 

Stage ID 
Specify the Stage ID. Note that this value can also be read 

dynamically. 

Source List ID 
Specify the Source List ID. Note that this value can also be read 

dynamically. 

Revision ID 
Specify the Revision ID. Note that this value can also be read 

dynamically. 

Blog ID 
Specify the Blog ID. Note that this value can also be read 

dynamically. 

Table Id or Table 

Name 

Specify the Table ID or Table Name. Note that this value can also 

be read dynamically. 

Version Id 
Specify the Version ID. Note that this value can also be read 

dynamically. 

Media type 

Specify the Media Type. Note that this value can also be read 

dynamically. 

Example: IMAGE 

 

For all possible values for this field, see HubSpot 

documentation. 
 

oEmbed Domain Id 
Specify the oEmbed Domain ID. Note that this value can also be 

read dynamically. 

Path 
Specify the Path. Note that this value can also be read 

dynamically. 

Content ID 
Specify the Content ID. Note that this value can also be read 

dynamically. 

Environment 

Specify the Environment. Note that this value can also be read 

dynamically. 

Example: draft 

 

For all possible values for this field, see HubSpot 

documentation. 
 

https://developers.hubspot.com/beta-docs/reference/api/overview
https://developers.hubspot.com/beta-docs/reference/api/overview
https://developers.hubspot.com/beta-docs/reference/api/overview
https://developers.hubspot.com/beta-docs/reference/api/overview


Field Description 

User ID 
Specify the User ID. Note that this value can also be read 

dynamically. 

Folder Path 
Specify the Folder Path. Note that this value can also be read 

dynamically. 

Folder ID 
Specify the Folder ID. Note that this value can also be read 

dynamically. 

File Name 
Specify the File Name. Note that this value can also be read 

dynamically. 

Options 

Specify a JSON object for file privacy and indexability. Note that 

this value can also be read dynamically. 

Example: {"access": "PUBLIC_INDEXABLE"} 

 

For more information and possible values for this field, see 

HubSpot documentation. 
 

Thread ID 
Specify the Thread ID. Note that this value can also be read 

dynamically. 

Actor ID 
Specify the Actor ID. Note that this value can also be read 

dynamically. 

Channel ID 
Specify the Channel ID. Note that this value can also be read 

dynamically. 

Channel Account ID 
Specify the Channel Account ID. Note that this value can also be 

read dynamically. 

Definition ID 
Specify the Definition ID. Note that this value can also be read 

dynamically. 

Callback ID 
Specify the Callback ID. Note that this value can also be read 

dynamically. 

https://developers.hubspot.com/beta-docs/reference/api/overview


Field Description 

Function Type 

Specify the Function Type. Note that this value can also be read 

dynamically. 

Example: PRE_ACTION_EXECUTION 

 

For all possible values for this field, see HubSpot 

documentation. 
 

Function ID 
Specify the Function ID. Note that this value can also be read 

dynamically. 

Email ID 
Specify the Email ID. Note that this value can also be read 

dynamically. 

Creation Timestamp 

Specify the Timestamp Created. Note that this value can also be 

read dynamically. 

Example: 2024-07-29T12:27:43.787Z 

Campaign ID 
Specify the Campaign ID. Note that this value can also be read 

dynamically. 

Breakdown By 

Specify the Breakdown By. Note that this value can also be read 

dynamically. 

Example: sessions 

 

For all possible values for this field, see HubSpot 

documentation. 
 

Content Type 

Specify the Content Type. Note that this value can also be read 

dynamically. 

Example: standard-pages  

 

For all possible values for this field, see HubSpot 

documentation. 
 

https://developers.hubspot.com/beta-docs/reference/api/overview
https://developers.hubspot.com/beta-docs/reference/api/overview
https://developers.hubspot.com/beta-docs/reference/api/overview
https://developers.hubspot.com/beta-docs/reference/api/overview
https://developers.hubspot.com/beta-docs/reference/api/overview
https://developers.hubspot.com/beta-docs/reference/api/overview


Field Description 

Time Period 

Specify the Time Period. Note that this value can also be read 

dynamically. 

Examples: weekly 

 

For all possible values for this field, see HubSpot 

documentation. 
 

External Event ID 
Specify the External Event ID. Note that this value can also be 

read dynamically. 

Subscriber State 

Specify the Subscriber State. Note that this value can also be 

read dynamically. 

Example: REGISTERED 

 

For all possible values for this field, see HubSpot 

documentation. 
 

Token Id 
Specify the Token ID. Note that this value can also be read 

dynamically. 

VID 

Specify the VID of the contact. Note that this value can also be 

read dynamically. 

 

This is helpful for integrations that display contact data in 

other interfaces. The contact's unique ID is stored in the 

'vid' field, which stands for 'visitor ID.' 
 

Offset 
Specify the offset as expected to the operation. Note that this 

value can also be read dynamically. 

Limit 
Specify the limit as expected for the operation. Note that this 

value can also be read dynamically. 

Property/Properties 
Specify the comma-separated values that are to be retrieved. 

Note that this value can also be read dynamically. 

Properties With 

History 

Specify the comma-separated values for which the history with 

timestamps should be retrieved. Note that this value can also be 

read dynamically. 

https://developers.hubspot.com/beta-docs/reference/api/overview
https://developers.hubspot.com/beta-docs/reference/api/overview
https://developers.hubspot.com/beta-docs/reference/api/overview
https://developers.hubspot.com/beta-docs/reference/api/overview


Field Description 

Query Parameters 
Specify comma-separated query parameters. Note that this value 

can also be read dynamically. 

Request Format 

Select the payload format of request body. 

Example: Application/XML 

Response Format 

Select the payload format of response body. 

Example: Application/JSON 

Header Details 

Request Headers 

Enter a list of custom headers, separated by a pipe (|), to send to 

the target system. By default, no custom headers are sent. Use an 

asterisk (*) to send all custom headers to the target system. 

Alternatively, you can dynamically pass the values by defining a 

property that includes a list of headers. 

Response Headers 

Enter a list of headers coming from the target system's response, 

separated by a pipe (|), to be received in the message. Use an 

asterisk(*) to receive all the headers from the target system, 

which is also the default value. 

 

  



5. HubSpot Adapter Operations 

This section lists and describes some of the operations supported by the HubSpot 

adapter. For a comprehensive list of all operations available in HubSpot, see Appendix, 

and for detailed information on any particular operation, see HubSpot documentation. 

There are two configuration types available to execute any operation which are Basic 

and Advanced by selecting the option in the dropdown. For more information about 

configuration, see below added operations. 

5.1 Basic Configuration 

In this section, you will find details of some operations using the basic configuration 

type. 

5.1.1 Create a batch of contacts (v3/CRM/Contacts)  
 

This operation is used to create a batch of contacts in HubSpot. These values must be 

specified by JSON in the request body. You can configure the processing tab as shown 

in the image below to execute this operation. 

Sample configuration: 

 
 

https://developers.hubspot.com/docs/getting-started/overview


Field Value 

Configuration 

Type 

Select the configuration type. 

Example:  Basic 

API Version Select an API version to connect to HubSpot. 

Example: v3 

Category Select a Category. 

Example: CRM 

Entity Select an Entity. 

Example: Contacts 

Operation Specify the operation to be executed. 

Example: Create a batch of contacts 

Payload Format Select the request and response payload format. It can be either 

XML or JSON. 

Example: application/XML 

You must provide the input data in the payload. 
{ 

  "inputs": [ 

    { 

      "associations": [ 

        { 

          "types": [ 

            { 

              "associationCategory": "HUBSPOT_DEFINED", 

              "associationTypeId": 0 

            } 

          ], 

          "to": { 

            "id": "string" 

          } 

        } 

      ], 

      "properties": { 

        "additionalProp1": "string", 

        "additionalProp2": "string", 

        "additionalProp3": "string" 

      } 

    } 

  ] 

} 



5.1.2 Update a company (v3/CRM/Companies)  

This operation is used to update an existing company with new properties or property 

values. These properties/values must be specified by JSON in the request body. You can 

configure the processing tab as shown in the image below to execute this operation. 

Sample configuration: 

 
 

Field Description 

Configuration 

Type 

Select the configuration type. 

Example: Basic 

API Version 

Select an API version to connect to HubSpot. 

Example: v3 

Category 

Select a Category. 

Example: CRM 



Field Description 

Operation 

Specify the operation to be executed. 

Example: Update a company 

Entity 

Select an Entity. 

Example: Companies 

Entity ID 

Specify the Entity ID corresponding to the Entity selected in the 

drop-down above. 

Example: For Entity 'Companies' enter the company ID. 

Query Parameters Specify a comma separated query parameters. 

Payload Format 

Select the request and response payload format. It can be either 

XML or JSON. 

Example: application/XML 

You must provide the input data in the payload. 

{ 

    "properties": { 

        "property_date": "1572480000000", 

        "property_radio": "option_1", 

        "property_number": "17", 

        "property_string": "value", 

        "property_checkbox": "false", 

        "property_dropdown": "choice_b", 

        "property_multiple_checkboxes": "chocolate;strawberry" 

    } 

} 

 

5.1.3 Read a deal (v3/CRM/Deals)  

In HubSpot, deals represent transactions with contacts or companies. This operation 

allows you to fetch the information related to a deal available in HubSpot. You can 

configure the processing tab as shown in the image below to execute this operation. 

 

 



 

Sample configuration: 

 
 

Field Description 

Configuration 

Type 

Select the configuration type. 

Example: Basic 

API Version 

Select an API version to connect to HubSpot. 

Example: v3 

Category 

Select a Category. 

Example: CRM 

Operation 

Specify the operation to be executed. 

Example: Read a deal 

Entity 

Select an Entity. 

Example: Deals 



Field Description 

Entity ID 

Specify the Entity ID corresponding to the Entity selected in the 

drop-down above. 

Example: For Entity 'Deals' enter the deal ID. 

Properties 

Specify a comma separated list of the properties to be returned in 

the response. If the requested deal does not have a value for a 

property, it will not appear in the response. 

Example: dealname 

Properties With 

History 

Specify a comma separated list of the current and historical 

properties to be returned in the response. If the requested deal does 

not have a value for a property, it will not appear in the response. 

Example: dealstatus 

Query 

Parameters 
Specify a comma separated query parameters. 

Payload Format 

Select the request and response payload format. It can be either 

XML or JSON. 

Example: application/XML 

 

5.1.5 Delete selected template (v2/CMS/Templates)  

 

This operation allows for the deletion of a specific template that is available in HubSpot. 

You can configure the processing tab as shown in the image below to execute this 

operation. 

 

 

 

 

 



Sample configuration: 

 
 

Field Description 

Configuration 

Type 

Select the configuration type. 

Example: Basic 

API Version 

Select an API version to connect to HubSpot. 

Example: v2 

Category 

Select a Category. 

Example: CMS 

Operation 

Specify the operation to be executed. 

Example: Delete selected template 

Entity 

Select an Entity. 

Example: Templates 

Entity ID 

Specify the Entity ID corresponding to the Entity selected in the 

drop-down above. 

Example: For Entity 'Template' enter the template ID. 



Field Description 

Payload Format 

Select the request and response payload format. It can be either 

XML or JSON. 

Example: application/XML 

 

5.1.6 Get an email event by ID (v1/Analytics and Events/Email 

Analytics)  

This operation allow to Query the event log for a specific event and get results for that 

email event. You can configure the processing tab as shown in the image below to 

execute this operation. 

Sample configuration: 

 
 

Field Description 

Configuration 

Type 

Select the configuration type. 

Example: Basic 

API Version 

Select an API version to connect to HubSpot. 

Example: v1 



Field Description 

Category 

Select a Category. 

Example: Analytics and Events 

Operation 

Specify the operation to be executed. 

Example: Email Analytics 

Entity 

Select an Entity. 

Example: Get an email event by ID 

Email ID Specify the Email ID. 

Creation 

Timestamp 

Specify the Timestamp Created. Note that this value can also be 

read dynamically. 

Example: 2024-07-29T12:27:43.787Z 

Payload Format 

Select the request and response payload format. It can be either 

XML or JSON. 

Example: application/XML 

 

5.1.7 Create an association (v4/CRM/Associations) 

 

In HubSpot, Associations represent the relationships between objects and activities in 

the HubSpot CRM. Record associations can exist between records of different objects  

(e.g., Contact to Company), as well as within the same object (e.g., Company to 

Company). 

This operation allows you to create an association in HubSpot.  

 

 

You can configure the processing tab as shown in the image below to execute this 

operation. 



 

Sample configuration:  

Field Description 

Configuration Type Select the configuration type. 

Example: Basic 

API Version Select an API version to connect to HubSpot. 

Example: v4 

Category Select a Category. 

Example: CRM 

Operation Specify the operation to be executed. 

Example: Create an association 

Entity Select an Entity. 

Example: Association 

To Object Type Specify the object you are associating the 

record to. 

Example: company 



Field Description 

Object Type Specify the type of the object you are 

associating.  

Example: contact 

Object ID Specify the ID of the record to associate. 

Example: 51 (Contact ID) 

To Object ID Specify the ID of the record to associate to. 

Example: 3164773776 (Company ID) 

You must provide the input data in the payload. 

{ 

  "inputs": [ 

    { 

      "types": [ 

        { 

          "associationCategory": "HUBSPOT_DEFINED", 

          "associationTypeId": 0 

        } 

      ], 

      "from": { 

        "id": "string" 

      }, 

      "to": { 

        "id": "string" 

      } 

    } 

  ] 

} 

5.2 Advanced Configuration 

This configuration type allows you to perform any operation by specifying the Endpoint 

URL and the request can be manually customized as per the requirement. 

 

Ensure the data matches HubSpot's acceptable format when using the 

Advanced configuration with the adapter. 

 

Sample configuration: 



 
 

 

Field Description 

Configuration 

Type 

Select the configuration type. 

Example: Advanced 

HTTP Method 

Select the http method. 

Example: POST 

Possible values: 

• DELETE 

• GET 

• HEAD 

• PATCH 

• POST 

• PUT 

Relative URL 

Specify the part of the endpoint excluding the host. 

Example: 
https://api.hubapi.com/crm/v3/objects/companies/batch/create 

Payload 

Format 

Select the request and response payload format. It can be either XML 

or JSON. 

Example: application/XML 

  



6. HubSpot Support 

6.1. Traces 

You can monitor, debug, and analyze errors or issues by changing the Log level of your 

integration flow to Traces. 

You can enable this under Log Configuration under Monitor > Manage Integration 

Content page in SAP Cloud Integration. 

 

The Trace Log level enables the collection of more traces to effectively understand the 

issues. These traces can also be used in a ticket.  

6.2. Troubleshooting  

6.2.1. Missing Query Parameters 
 

Error  Reason Resolution 

Example error message for the operation Get all 

events: 

{"status":"error","message":"Must specify an 

eventType or 

objectType","correlationId":"13ab7160-2be8-

438c-9af9-

07cf3ec16a62","category":"VALIDATION_ERROR"} 

The 

required 

query 

parameter 

for this 

operation is 

missing. 

Include the 

required query 

parameter in the 

query parameter 

field under Basic 

configuration or 

add it to the 

relative URL for 

Advanced 

configuration. 

 

  



7. References 

7.1. XSD Generator  

The XSD Generator is developed to support mapping operations in integration 

scenarios. It generates request and response XSDs for multiple endpoints that are 

specific to the HubSpot instance. 

In the image below, the right side of the view contains a request and response tab that 

will show the resulting XSD. 

 

To generate the XSD: 

1. Open Eclipse.  

2. Go to Windows > Perspective > Open Perspective > Other.  

3. Select HubSpot Workbench Adapter and click Open.  

4. Select API Version, Category and Entity from the respective dropdowns.    

5. Choose the operation from the HubSpot Operation list that matches the 

selected category and entity. 

6. Click Generate XSD. 

7. Click Save to save the displayed XSD. Switch tabs to save the corresponding 

response/request. Click Copy Text to copy the XSD text to your clipboard.  



8. Appendix 

This section lists and describes all the operations supported by the HubSpot adapter. 

The below operations are arranged as per the HubSpot API version specified for Basic 

configuration. For detailed information on any particular operation, see HubSpot 

documentation. 

The following tables provides information regarding the configuration of various 

operations available in HubSpot. 

API 

Version 
Category Entity Operation 

v1 
Analytics 

& Events 

Email 

Analytics 

Get all campaign IDs for a portal, Get an email 

event by ID, Get email events, Get campaign data 

for a given campaign, Get campaign IDs with 

recent activity for a portal 

v1 Marketing 
Marketing 

Emails 

Clone a marketing email, Create a marketing 

email, Delete a marketing email, Determine the 

buffer of a marketing email, Get all marketing 

emails, Get revisions of a marketing email, Get the 

details for a marketing email, Get the statistics for 

a marketing email, Get the statistics of all 

marketing emails, Restore a deleted marketing 

email, Update a marketing email 

v1 CMS 
Media 

Bridge 

Create a media bridge setting, Read a media 

bridge setting, Update a media bridge setting, 

Update a media bridge object definition, Read a 

media bridge object definition by media type, 

Delete a media bridge oembed domain, Read a 

media bridge oembed domain, Update a media 

bridge oembed domain, Read a media bridge 

oembed domain by ID, Update a media bridge 

oembed domain by ID, Update a media bridge 

setting register 

https://developers.hubspot.com/docs/getting-started/overview
https://developers.hubspot.com/docs/getting-started/overview


API 

Version 
Category Entity Operation 

v2 CMS Layouts 

Determine if the auto-save buffer differs from the 

live layout, Get the layout by ID, Get the previous 

version of the layout, Gets the current contents of 

the auto-save buffer for a layout, List layouts, List 

previous versions of the layout 

v2 
Analytics 

& Events 
Reporting 

Check for the existence of analytics data for an 

object type, Get a Group of Events by ID, Get all 

analytics views, Get analytics data breakdowns, 

Get analytics data for HubSpot hosted content, 

Get analytics data for specific objects, Get Events 

v2 CMS Templates 

Copy the contents of the auto-save buffer into the 

live template, Create a new template, Delete 

selected template, Determine if the auto-save 

buffer differs from the live template, Get the 

previous version of the template, Get the template 

by ID, Get the current contents of the auto-save 

buffer for a template, List previous versions of the 

template, List templates, Restore a previous 

version of the template, Restore a previously 

deleted template, Update the template, Update 

the auto-save buffer 

v2 
Automati

on 

Create and 

Manage 

Workflows 

Current enrolment, Enroll a contact into a 

workflow, Unenroll a contact from a workflow,  

v3 Settings 
Account 

Information 

Get account details, Get activity audit logs, Get 

daily API usage, Get login activity, Get security 

activity,   

v3 CRM Associations 

Archive a batch of associations, Create a batch of 

associations, List association types, Read a batch 

of associations, 



API 

Version 
Category Entity Operation 

v3 CMS Blog Authors 

Attach a Blog Author to a multi-language group, 

Create a batch of Blog Authors, Create a new Blog 

Author, Create a new language variation for a blog 

author, Delete a batch of Blog Authors, Delete a 

Blog Author, Detach a Blog Author from a multi-

language group, Get all Blog Authors, Retrieve a 

batch of Blog Authors, Retrieve a Blog Author, Set 

a new primary language for Blog Author, Update a 

batch of Blog Authors, Update a Blog Author, 

Update languages of multi-language group for 

blog authors,  

v3 CMS Blog Posts 

Attach a Blog Post to a multi-language group, 

Clone a Blog Post, Create a batch of Blog Posts, 

Create a new Blog Post, Create a new language 

variation, Delete a batch of Blog Posts, Delete a 

Blog Post, Detach a Blog Post from a multi-

language group, Get all Blog Posts, Push Blog Post 

draft edits live, Reset the Blog Post draft to the live 

version, Restore a previous version of a blog post, 

Restore a previous version of a blog post to draft, 

Retrieve a batch of Blog Posts, Retrieve a Blog 

Post, Retrieve the draft version of the Blog Post, 

Retrieves a previous version of a blog post, 

Retrieve all the previous versions of a blog post, 

Schedule a Blog Post to be Published, Set a new 

primary language for a blog post, Update a batch 

of Blog Posts, Update a Blog Post draft, Update a 

Blog Post, Update languages of multi-languages 

group for a blog post 



API 

Version 
Category Entity Operation 

v3 CMS Blog Settings 

Attach a blog to a multi-language group, Create a 

new language variation from an existing blog, 

Detach a blog from a multi-language group, Get 

the list of Blogs settings, Retrieve the Blog object 

identified by the id in the path, Retrieve a previous 

version of a Blog, Retrieve all the previous versions 

of a Blog, Set a blog as the primary language of a 

multi-language group, Set new languages for each 

blog in a multi-language group 

v3 
Automati

on 

Create and 

Manage 

Workflows 

Create a workflow, Delete a workflow, Get 

performance statistics for a workflow, Get 

workflow by ID, Get workflows 

v3 CMS Blog Tags 

Attach a Blog Tag to a multi-language group, 

Create a batch of Blog Tags, Create a new Blog 

Tag, Create a new language variation for a blog 

post, Delete a batch of Blog Tags, Delete a Blog 

Tag, Detach a Blog Tag from a multi-language 

group, Get all Blog Tags, Retrieve a batch of Blog 

Tags, Retrieve a Blog Tag, Set a new primary 

language for Blog Post, Update a batch of Blog 

Tags, Update a Blog Tag, Update languages of 

multi-language group for blog tags 

v3 CMS 
Content 

Audit 
Query audit logs 

v3 Settings 
Business 

Units 
Get Business Units for a user 

v3 CRM Calling SDK 

Configure a calling extension, Configure recording 

settings, Delete calling settings, Get calling 

settings, Get recording settings, Update recording 

settings, Update settings for calling extensions 



API 

Version 
Category Entity Operation 

v3 CRM Calls 

Archive a batch of calls by ID, Archive a call, Create 

a batch of calls, Create a call, GDPR DELETE a call, 

List a page of calls, Merge two calls with same 

type, Read a batch of calls, Read a call, Update a 

batch of calls, Update a call 

v3 CRM CRM Cards 

Create a new card, Delete a card, Get a card, Get 

all cards, Get sample card detail response, Update 

a card 

v3 CRM 
Communicati

ons 

Archive a batch of communications by ID, Archive 

a communication, Create a batch of 

communications, Create a communication, GDPR 

DELETE a communication, List a page of 

communications, Merge two communications with 

same type, Read a batch of communications, Read 

a communication, Update a batch of 

communications, Update a communication 

v3 CRM Companies 

Archive a batch of companies by ID, Archive a 

company, Create a batch of companies, Create a 

company, GDPR DELETE a company, List a page of 

companies, Merge two companies with same type, 

Read a batch of companies, Read a company, 

Update a batch of companies, Update a company 

v3 CRM Contacts 

Archive a batch of contacts by ID, Archive a 

contact, Create a batch of contacts, Create a 

contact, GDPR DELETE a contact, List a page of 

contacts, Merge two contacts with same type, 

Read a batch of contacts, Read a contact, Update 

a batch of contacts, Update a contact 

v3 
Analytics 

& Events 

Custom 

Behavioral 

Events 

Send Custom Behavioral Event 



API 

Version 
Category Entity Operation 

v3 CRM 
Custom 

Objects 

Archive a batch of objects by ID, Archive a custom 

object, Create a batch of objects, Create a custom 

object, GDPR DELETE a custom object, List a page 

of custom objects, Merge two objects with same 

type, Read a batch of objects, Read a custom 

object, Update a batch of objects, Update a 

custom object 

v3 CRM Deals 

Archive a batch of deals of ID, Archive a deal, 

Create a batch of deals, Create a deal, GDPR 

DELETE a deal, List a page of deals, Merge two 

deals with same type, Read a batch of deals, Read 

a deal, Update a batch of deals, Update a deal 

v3 CMS Domains Get a single domain, Get current domains 

v3 CRM Email 

Archive a batch of emails by ID, Archive an email, 

Create a batch of emails, Create an email, GDPR 

DELETE an email, List a page of emails, Merge two 

emails with same type, Read a batch of emails, 

Read an email, Update a batch of emails, Update 

an email 

v3 CRM 
Export CRM 

data 

Get the status of the export including the URL to 

download the file, Start an export 

v3 CRM 
Feedback 

Submissions 

Archive a batch of feedback submissions by ID, 

Archive a feedback submission, Create a batch of 

feedback submissions, Create a feedback 

submission, GDPR DELETE a feedback submission, 

List a page of feedback submissions, Merge two 

feedback submissions with same type, Read a 

batch of feedback submissions, Read a feedback 

submission, Update a batch of feedback 

submissions, Update a feedback submission 



API 

Version 
Category Entity Operation 

v3 Files Files  

Check import status, Delete file, GDRP DELETE a 

file, Get a file by ID, Get a file by path, Get signed 

URL to access private file, Import a file from a URL 

into the file manager, Replace file, Search files, 

Update file properties, Upload file 

v3 Files Folders 

Check folder update status, Create folder, Delete 

folder by ID, Delete folder by path, Get a folder by 

ID, Get a folder by path, Search folders, Update 

folder properties 

v3 CRM Goals 

Archive a batch of goal targets by ID, Archive a 

goal, Create a batch of goal targets, Create a goal, 

GDPR DELETE a goal, List a page of goals, Merge 

two goal targets with same type, Read a batch of 

goals, Read a goal, Update a batch of goal targets, 

Update a goal 

v3 CMS HubDb Rows 

Add a new row to a table, Clone a row, Clone rows 

in batch, Create rows in batch, Delete rows 

permanently, Get a row from the draft table, Get a 

set of rows, Get a set of rows from draft table, Get 

a table row, Get rows from a table, Get rows from 

a draft table, Permanently delete a row, Replace an 

existing row, Replace rows in batch in draft table, 

Update an existing row, Update rows in batch in 

draft table 

v3 CMS 
HubDb 

Tables 

Archive a table, Import data into draft table, Clone 

a table, Create a new table, Export a draft table, 

Export a published version of a table, Get all 

published tables, Get details for a draft table, Get 

details for a published table, Publish a table from 

draft, Reset a draft table, Return all draft tables, 

Unpublish a table, Update an existing table 

v3 CRM 
Import CRM 

data 

Cancel an active import, Check errors in import, 

Get active import, Get the information on any 

import, Start a new import 



API 

Version 
Category Entity Operation 

v3 
Conversat

ions 

Inbox & 

Messages 

Archive a thread, Get a single actor, Get a single 

channel, Get a single channel account, Get a single 

conversations inbox, Get a single message, Get a 

single thread, Get actors, Get channel accounts, 

Get channels, Get conversations inboxes, Get 

message history for a thread, Get the original 

content of a single message, Get threads, Send a 

message to a thread, Update a thread 

v3 CRM Line Items 

Archive a batch of line items by ID, Archive a line 

item, Create a batch of line items, Create a line 

item, GDPR DELETE a line item, List a page of line 

items, Merge two line items with same type, Read 

a batch of line items, Read a line item, Update a 

batch of line items, Update a line item 

v3 CRM Lists 

Add All Records from a Source List to a 

Destination List, Add and/or Remove Records from 

a List, Add Records to a List, Delete All Records 

from a List, Fetch list Memberships Ordered by ID, 

Remove Records from a List 

v3 Marketing 
Marketing 

Emails 

Clone a marketing email, Create a marketing 

email, Delete a marketing email, Get revisions of a 

marketing email, Get all marketing emails, Get the 

details for a marketing email, Update a marketing 

email, Complete an event, Create a marketing 

event, Create or update a marketing event, Create 

or update multiple marketing events, Delete a 

marketing event, Delete multiple marketing 

events, Get a marketing event, Mark a marketing 

event as cancelled, Record a subscription state by 

email, Record a subscription state by email if 

exists, Record a subscription state by ID, Record a 

subscription state by Id if exists, Retrieve the 

application settings, Search for marketing events, 

Update a marketing event, Update the application 

settings 



API 

Version 
Category Entity Operation 

v3 CRM Meetings 

Archive a batch of meetings by ID, Archive a 

meeting, Create a batch of meetings, Create a 

meeting, GDPR DELETE a meeting, List a page of 

meetings, Merge two meetings with same type, 

Read a batch of meetings, Read a meeting, Update 

a batch of meetings, Update a meeting 

v3 CRM Notes 

Archive a batch of notes by ID, Archive a note, 

Create a batch of notes, Create a note, GDPR 

DELETE a note, List a page of notes, Merge two 

notes with same type, Read a batch of notes, Read 

a note, Update a batch of notes, Update a note 

v3 CRM Owners 
Get a page of owners, Read an owner by given Id 

or user Id 

v3 CMS Pages 

Attach a landing page to a multi-language group, 

Attach a site page to a multi-language group, 

Clone a Landing Page, Clone a Site Page, Create a 

batch of Folders, Create a batch of Landing Pages, 

Create a batch of Site Pages, Create a new A/B test 

variation for landing page, Create a new A/B test 

variation for site page, Create a new Folder, Create 

a new Landing Page, Create a new language 

variation for a landing page, Create a new 

language variation for a site page, Create a new 

Site Page, Delete a batch of Folders, Delete a 

batch of Landing Pages, Delete a batch of Site 

Pages, Delete a Folder, Delete a Landing Page, 

Delete a Site Page, Detach a landing page from a 

multi-language group, Detach a site page from a 

multi-language group, End an active A/B test for 

landing page, End an active A/B test for site page, 

Get all Landing Page Folders, Get all Landing 

Pages, Get all Site pages, Push Landing Page draft 

edits live, Push Site Page draft edits live, Rerun a 

previous A/B test for landing page, Rerun a 

previous A/B test for site page, Reset the Landing 



API 

Version 
Category Entity Operation 

Page draft to the live version, Reset the Site Page 

draft to the live version, Restore a previous version 

of a Folder, Restore a previous version of a 

Landing Page to the draft version of the Landing 

Page, Restore a previous version of a Site Page, 

Restore a previous version of a Site Page to the 

draft version of the Site Page, Restore a previous 

version of a Landing Page, Retrieve a batch of 

Landing Pages, Retrieve a batch of Site Pages, 

Retrieve a Folder, Retrieve a Landing Page, 

Retrieve a Site Page, Retrieve the full draft version 

of the Landing Page, Retrieve the full draft version 

of the Site Page, Retrieve a batch of Folders, 

Retrieve a previous version of a Folder, Retrieve a 

previous version of a Landing Page, Retrieve a 

previous version of a Site Page, Retrieve all the 

previous versions of a Folder, Retrieve all the 

previous versions of a Landing Page, Retrieve all 

the previous versions of a Site Page, Schedule a 

Landing Page to be Published, Schedule a Site 

Page to be Published, Set a new primary language 

for landing page, Set a new primary language for 

site page, Update a batch of Folders, Update a 

batch of Landing Pages, Update a batch of Site 

Pages, Update a Folder, Update a Landing Page, 

Update a Landing Page draft, Update a Site Page 

draft, Update a Site Page, Update languages of 

multi-language group for a landing page, Update 

languages of multi-language group for a site page 

v3 CMS Performance 
View your website's performance, View your 

website's uptime 



API 

Version 
Category Entity Operation 

v3 CRM Pipelines 

Create a pipeline, Create a pipeline stage, Delete a 

pipeline, Delete a pipeline stage, Replace a 

pipeline, Replace a pipeline stage, Retrieve all 

pipelines, Return a pipeline by ID, Return a 

pipeline stage by ID, Return all stages of a 

pipeline, Return an audit of all changes to the 

pipeline, Return an audit of all changes to the 

pipeline stage, Update a pipeline, Update a 

pipeline stage 

v3 CRM Postal Mail 

Archive a batch of postal mail by ID, Archive a 

postal mail, Create a batch of postal mail, Create a 

postal mail, GDPR DELETE a postal mail, List a 

page of postal mails, Merge two postal mails with 

same type, Read a batch of postal mail, Read a 

postal mail, Update a batch of postal mails, 

Update a postal mail 

v3 CRM Products 

Archive a batch of products by ID, Archive a 

product, Create a batch of products, Create a 

product, GDPR DELETE a product, List a page of 

products, Merge two products with same type, 

Read a batch of products, Read a product, Update 

a batch of properties, Update a product 

v3 CRM Properties 

Archive a batch of properties, Archive a property, 

Archive a property group, Create a batch of 

properties, Create a property, Create a property 

group, Read a batch of properties, Read a 

property, Read a property group, Read all 

properties, Read all property groups, Update a 

property, Update a property group 

v3 CRM Quotes 

Archive a batch of quotes by ID, Archive a quote, 

Create a batch of quotes, Create a quote, GDPR 

DELETE a quote, List a page of quotes, Merge two 

quotes with same type, Read a batch of quotes, 

Read a quote, Update a batch of quotes, Update a 

quote 



API 

Version 
Category Entity Operation 

v3 Search Search 

Search a call, Search a communication, Search a 

company, Search a contact, Search a deal, Search a 

discount, Search a fee, Search a feedback 

submission, Search a goal, Search a line item, 

Search a meeting, Search a note, Search a postal 

mail, Search a product, Search a quote, Search a 

task, Search a tax, Search a ticket, Search an email, 

Search an object, Search lists 

v3 CMS Site Search Get indexed properties, Search your site 

v3 CMS Source Code 

Check extract zip (async) status, Create a file, 

Create or update a file, Delete a file, Download a 

file, Extract a zip file, Extract a zip file (async), Get 

the metadata for a file, Validate the contents of a 

file 

v3 Marketing 
Subscription 

Preferences 

Get subscription definitions, Get subscription 

statuses for a contact, Subscribe a contact, 

Unsubscribe a contact 

v3 CRM Tasks 

Archive a batch of tasks by ID, Archive a task, 

Create a batch of tasks, Create a task, GDPR 

DELETE a task, List a page of tasks, Merge two 

tasks with same type, Read a batch of tasks, Read 

a task, Update a batch of tasks, Update a task 

v3 CRM Taxes 

Archive a batch of taxes by ID, Archive a tax, 

Create a batch of taxes, Create a tax, GDPR DELETE 

a tax, List a page of taxes, Merge two taxes with 

same type, Read a batch of taxes, Read a tax, 

Update a batch of taxes, Update a tax 

v3 CRM Tickets 

Archive a batch of tickets by ID, Archive a ticket, 

Create a batch of tickets, Create a ticket, GDPR 

Delete a ticket, List a page of tickets, Merge two 

tickets with same type, Read a batch of tickets, 

Read a ticket, Update a batch of tickets, Update a 

ticket 



API 

Version 
Category Entity Operation 

v3 CRM 
Timeline 

Events 

Add a token to an existing event template, Create 

a single event, Create an event template for your 

app, Create multiple events, Delete an event 

template for the app, Get a specific event template 

for your app, Gets the detail template as rendered, 

Get an event, List all event templates for your app, 

Remove a token from the event template, Render 

the header or detail as HTML, Update an existing 

event template, Update an existing token on an 

event template 

v3 Marketing 
Transactional 

Email 

Create a SMTP API token, Delete a single token by 

ID, Query a single token by ID, Query SMTP API 

tokens by campaign name or an emailCampaignId, 

Reset the password of an existing token, Send a 

single transactional email asynchronously 

v3 CMS 
URL 

Redirects 

Create a redirect, Delete a redirect, Get current 

redirects, Get details for a redirect, Update a 

redirect,  

v3 Settings 
User 

Provisioning 

Add a user, Modifies a user, Remove a user, 

Retrieve a list of users from an account,  Retrieve a 

user, Retrieve the roles on an account, View teams 

for this account 

v3 CRM 

Video 

Conference 

Extension 

Delete settings of a video conference extension, 

Get settings of a video conference extension, 

Update settings for a video conference extension 

v3 
Conversat

ions 

Visitor 

Identification 
Generate a token 

v3 
Analytics 

& Events 

Event 

Analytics 
Get all events 

v3 
Webhook

s 
Settings 

Create or update webhook settings, Delete 

webhook settings, Get webhook settings 



API 

Version 
Category Entity Operation 

v3 
Webhook

s 

Subscription

s 

Create a webhook subscription, Delete a 

subscription, Get a subscription, List subscriptions, 

Update a subscription, Update multiple webhook 

subscriptions 

v4 CRM Associations 

Create an association, Create Default associations, 

Create Default batch Associations, Delete a batch 

of associations, Delete all associations between 

two objects, Delete Specific Labels, List all 

associations of an object, Read an association 

v4 
Automati

on 

Custom 

Workflow 

Actions 

Archive a single custom workflow action with the 

specified ID, Complete the given action callback 

by ID, Complete the given action callbacks, 

Creates a new custom workflow action, Create or 

replace a function for a custom workflow action, 

Creates or replaces a function for a custom 

workflow action by ID, Delete a function for a 

custom workflow action, Delete a function for a 

custom workflow action by ID, Returns a list of all 

custom workflow actions, Get all functions for a 

given definition, Return a list of revisions for a 

custom workflow action, Return a single custom 

workflow action with the specified ID, Return the 

given function for a custom workflow action, 

Return the given function for a custom workflow 

action by ID, Returns the given version of a 

custom workflow action, Update a custom 

workflow action with new values for the specified 

fields 
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